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Practical Manual

Notes

Data Entry Operations

Carefully observe the picture of the computer system given below. Identify the
peripheral components marked with the arrows and write their name in the
respective boxes.

Objective

After completing this practical you will be able to identify different peripheral
parts of the computer.

Software Required

Any Operating system.

Prerequisite

Knowledge of computer hardware.

Procedure

Step 1: Identify the peripheral components marked with the arrows.

Step 2: Mention their name in the box provided in the picture next to the
component.
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Dos and Don’ts

Do refer to your course material in case of any doubt.

Learner’s Observations

...........................................................................................................................

...........................................................................................................................

...........................................................................................................................

...........................................................................................................................

...........................................................................................................................

...........................................................................................................................

...........................................................................................................................

...........................................................................................................................

...........................................................................................................................

...........................................................................................................................

(Instructor’s Signature)
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Observe the computer system in your lab or at home. Make a list of any three
hardware components and mention their purpose in the table given below. For
your reference, the information about keyboard has been filled in the first row.

S.No. Hardware Purpose

0. Keyboard It is used to feed the instructions into the
computer’s memory.

1.

2.

3.

Objectives

After completing this practical you will be able to:

Identify different parts of the computer;

Explain the purpose of different peripheral devices.

Software Required

Windows Operating system

Prerequisite

Knowledge of hardware.

Procedure

Step 1: Identify few hardware parts of the computer which can be seen and
touched like keyboard, mouse, monitor etc.

Practical 2



Practical Manual

 4

Notes

Data Entry Operations

Step 2: Mention the purpose of each component in simple words in the
column provided.

Dos and Don’ts

Observe and use only external hardware devices.

Learner’s Observations

...........................................................................................................................

...........................................................................................................................

...........................................................................................................................

...........................................................................................................................

...........................................................................................................................

...........................................................................................................................

...........................................................................................................................

...........................................................................................................................

...........................................................................................................................

...........................................................................................................................

(Instructor’s Signature)
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Switch on the Computer System and Login in Windows operating system.

Objectives

After completing this practical you will be able to:

Start computer system;

Login in windows operating system.

Software Required

Windows XP or any higher version.

Prerequisite

Knowledge of basic operation of computer system.

Procedure

Step-1: Press the big button known as “Power/Start Button” present at the front

side of the CPU box, which may look alike as shown here in the picture .

Wait for a few seconds.

When the computer system is loaded with Windows operating system, it will
present a log-in screen to log on to windows or to network, if the system is part
of a computer network.

Step-2: Enter the password (if it is password protected)

Step-3: Click on the ‘a’ key or hit the Enter key.

You will be able to successfully login into the Windows system.
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Dos and Don’ts

Do remember that the password used is case sensitive, so enter in the correct
case only.

Do not press the Start button multiple times unnecessarily.

Learner’s Observations

...........................................................................................................................

...........................................................................................................................

...........................................................................................................................

...........................................................................................................................

...........................................................................................................................

...........................................................................................................................

...........................................................................................................................

...........................................................................................................................

...........................................................................................................................

...........................................................................................................................

(Instructor’s Signature)
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Explore all the software installed on your computer system. Make a list of any
three software and mention their purpose as well. For your reference, the
information about Windows has been filled in the first row.

S.No. Software Purpose

0. Windows It is an operating system, used to operate the
computer system..

1.

2.

3.

Objectives

After completing this practical you will be able to:

List various software already installed on your computer;

Explain the purpose of each software.

Software Required

Windows Operating system.

Other general purpose software for typing, performing calculations, drawing,
playing music, etc.

Prerequisite

Knowledge of software and basic operation of computer systems.

Procedure

Step 1: Switch on the computer system. Explore the software already
installed on your computer.
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Step 2: Try understanding the purpose of each software and mention it in
simple words in the column provided.

Dos and Don’ts

Make sure you write correct name of each software.

Shut down the computer by clicking the Shut Down button.

Learner’s Observations

...........................................................................................................................

...........................................................................................................................

...........................................................................................................................

...........................................................................................................................

...........................................................................................................................

...........................................................................................................................

...........................................................................................................................

...........................................................................................................................

...........................................................................................................................

...........................................................................................................................

(Instructor’s Signature)
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Explore and identify various Windows Desktop elements.

Objective

After completing this practical you will be able to list various desktop elements.

Software Required

Windows XP or higher version.

Prerequisite

Basic knowledge of working in Windows operating system,

Procedure

After successfully logging in into the Windows operating system, Window’s
desktop will appear on the screen, which may have following main elements:

Taskbar

Start menu

Icons of various software applications

To identify these components, follow the given steps:

Step-1: Longest bar running at the bottom of the screen, having the “Start
Button” at its extreme left and “Clock” at its extreme right is known as Task Bar.

Step-2: By clicking on the “Start Button” present at the extreme left of the task
bar, “Start Menu” will appear on the screen giving all the available options to
start using the Windows.

Step-3: Different icons like “My Computer”, “Recycle Bin” etc., will be
displayed on the desktop screen (Windows XP).
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Dos and Don’ts

Do explore different options available on the screen, like start menu, clock
etc.

Do not open more technical options like control panel at this moment.

Learner’s Observations
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Start any program like paint from the Start Menu in any Windows operating
system.

Objectives

After completing this practical you will be able to:

Explore Windows operating system to find the required program;

Open the required program to start working on it.

Software Required

Windows XP or any higher version

Prerequisite

Basic knowledge of working in Windows operating system.

Procedure

To start a program follow the steps given below:

Step-1: Click on the Start Button.

Step-2: Click on the All Programs.

Step-3: Point to the desired folder say “Accessories” and select the desired
program to run such as ‘Paint’.

The MS Paint window will appear on the desktop.

Dos and Don’ts

Only open those programs (in this case MS Paint ), which are required by
you.
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Learner’s Observations
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Explore different ways to quit the program in any Windows operating system.

Objective

After completing this practical you will be able to close the application(s) to free
up memory and unclutter your screen.

Software Required

Windows XP or higher version.

Prerequisite

Basic knowledge of working in Windows operating system.

Procedure

Follow any of the following two options to quit a program:

Step 1: Click on File menu.

Step 2: Select ‘Close’ option

OR

Select the close button (×) in the upper-right corner of the window.

Dos and Don’ts

Do not leave multiple programs running unnecessarily as it will slow down
the overall processing.

Do remember to close the application(s) which are not in use.
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Learner’s Observations
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Get online help on a specific topic.

Objective

After completing this practical you will be able to understand the process of
getting online help on any specific topic.

Software Required

Windows XP or higher version.

Prerequisite

Basic knowledge of working in Windows operating system.

Procedure

Online help and support provided is of great help in using and learning windows.
One can get help on any specific topic or current task that is being executed. To
start help:

Step-1: Click on the Start button.

Step-2: Click on ‘Help and Support’ option.

A list of help and support topics and online tutorials is displayed on the screen.
One can use the tabs on the screen to search for the desired information in several
ways.

Dos and Don’ts

You should have a good internet connection to get proper online help and
support.

Do not try to fix up any technical issue in the beginning without proper
knowledge of the system.
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Learner’s Observations

...........................................................................................................................

...........................................................................................................................

...........................................................................................................................

...........................................................................................................................

...........................................................................................................................

...........................................................................................................................

...........................................................................................................................

...........................................................................................................................

...........................................................................................................................

...........................................................................................................................

(Instructor’s Signature)



 17

Practical Manual

Notes

Data Entry Operations

Create a new folder in “My Documents”.

Objective

After completing this practical you will be able to create various folders as per the
requirement.

Software Required

Windows XP or higher version.

Prerequisite

Basic knowledge of working in Windows operating system,

Procedure

To create a new folder in ‘My Documents’, follow the steps given below:

Step-1: Click on Start, and then click on My Documents.

Step-2: Under the File menu, click New and select Folder.

Step-3: A new folder is displayed with the default name, New Folder.

Step-4: Type a name for the new folder, and then press ENTER.

Note: A new folder can also be created by right-clicking on a blank area in a folder
window or on the desktop (to create a folder on the desktop) pointing to New, and
then clicking Folder option.

Dos and Don’ts

Please ensure the location where the folder is being created otherwise it will
be tough to locate later on.

Do not give the same name to different folders as two folders with the same
name cannot exist at the same location.
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Learner’s Observations
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Create a document in MS Word.

Objective

After completing this practical you will be able to open the MS-Word program
and type the desired text.

Software Required

Windows XP or higher version.

MS-Office 2007 or higher version.

Prerequisite

Basic knowledge of working in Windows operating system.

Procedure

There are different ways to start MS-Word program. One way is using Start
button by following the steps given below:

Step-1: Click on the Start button.

Step-2: From the start menu that appears, select All Programs →→→→→ MicrosoftOffice
→→→→→ Microsoft Office Word 2007.

OR

You can also start your MS Word program by double clicking on Microsoft Word
icon, which lies on the Microsoft Office Shortcut Bar (MOSB).

In few seconds you will see the Word screen on the monitor.

Select Blank Document and start typing few lines about yourself.

OR
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To open a new document, follow one of the following methods:

Click the New Document button on the menu bar.

Press CTRL+N keys on the keyboard.

A new blank document will appear on the screen, start typing few lines about
yourself.

Dos and Don’ts

Do remember to close the program when you are not using it.

Do not open multiple instances of the same program to avoid confusion.

Learner’s Observations
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Save the recently created document for future use.

Objectives

After completing this practical you will be able to save the document for future
use.

Software Required

Windows XP or higher version.

MS-Office 2007 or higher version.

Prerequisite

Basic knowledge of working in Windows operating system and MS-Word.

Procedure

Once done typing in MS-Word, save and close the document by following the
steps as given below:

1. Click the Save  button on the menu bar.

OR

Press CTRL+S keys on the keyboard.

The “Save As” dialog box will appear.

2. Select the folder where you want to place your document in Save In: box

3. Type the name of the document in File Name: box

4. Click OK button. Your file will be saved with the given name.

Note: The Save As dialog box will not appear if you try to save an already saved
file. In that case, clicking on Save button will save the changes made in the
document.
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Dos and Don’ts

Do remember to keep saving your document at regular intervals.

Do not save your document with any irrelevant name as it may be tough for
you to recall that name in future.

Learner’s Observations
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Open an existing Document.

Objective

After completing this practical you will be able to open an existing document.

Software Required

Windows XP or higher version.

MS-Office or higher version.

Prerequisite

Basic knowledge of working in MS-Word.

Procedure

Follow the steps to open any existing document:

Step 1: Click on the Office 2007 button on the top left corner of your document
screen.

Step 2: Follow one of the following methods:

Click the Open button on the menu bar.

OR

Press CTRL+O keys on the keyboard.

Each of the above methods will show the Open dialog box.

Step 3: Choose the desired file and click the Open button.

Desired file will appear on the screen.
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Dos and Don’ts

Do remember to close the document when not using it.

Do not open multiple documents unnecessarily as it will slow down the
overall processing.

Learner’s Observations
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Carefully observe the screenshot of MS-Word screen along with the list of
components given below. Identify and write the names of different components in
the respective boxes.

Components of MS Word Window

Status Bar, Close Button, Office Button, Ruler, Horizontal Scroll Bar, Ribbon,
Title Bar, Vertical Scroll Bar, Insertion Point, Quick Access Toolbar, Document
Window, View Buttons, Zoom Slider
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Objective

After completing this practical you will be able to identify different components of
MSWord window.

Software Required

Any Operating system

MS-Word 2007 or higher version

Prerequisite

Basic knowledge of MS-Word

Procedure

Step 1: Identify different components marked with the lines and empty
boxes.

Step 2: Mention their name in the respective box provided.

Dos and Don’ts

Do refer to your course material in case of any doubt.

Only observe the main components, do not focus on the sub menus at this
moment.

Learner’s Observations
...........................................................................................................................
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Insert the text in an existing document in MSWord.

Objectives

After completing this practical you will be able to insert the text in an existing
document in MS-Word.

Software Required

Windows XP or higher version.

MS-Office -2007 or higher version.

Prerequisite

Knowledge of working in MSWord.

Procedure

To insert the text in an existing document, follow the steps given below:

Step 1: Move the cursor by using the arrow buttons on the keyboard or by
positioning the mouse pointer at the desired location and then clicking the left
mouse button. This will position the cursor at the location where the text has to
be inserted.

The keyboard shortcuts listed below are also helpful to position the cursor at the
desired location in the document.

Beginning of the line : HOME

End of the line : END

Top of the document : CTRL+HOME

End of the document : CTRL+END.

Step 2: Type the text which you want to insert.
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Dos and Don’ts

Do remember that text will appear where the blinking cursor is located.

Do not press the Enter key at the end of each line as due to the “Word Wrap”
feature, the characters automatically shifted to the next line.

Learner’s Observations
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Selecting (Highlighting) text in an MS-Word document.

Objective

After completing this practical you will be able to select (Highlight) the text in a
document created in MS-Word.

Software Required

Windows XP or higher version.

MS-Office -2007 or higher version.

Prerequisite

Knowledge of working in MSWord.

Procedure

To change any attributes of the text it must be highlighted first. Follow the step as
given below for the same:

Step 1: Select the text by dragging the mouse over the desired text while keeping
the left mouse button pressed.

OR

Hold down the SHIFT key on the keyboard while using the arrow buttons to
highlight the text.

The shortcuts for selecting a portion of the text may also be used, which are as
follows:

(a) Whole word: double-click within the word.

(b) Whole paragraph: triple-click within the paragraph.
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(c) Several words or lines: drag the mouse over the words, or hold down SHIFT
key while using the arrow keys.

(d) Entire document: choose Edit →→→→→ Select All or press CTRL+A keys.

Step 2: As desired the text is selected, you can perform any required operation like
deleting, replacing etc.

Dos and Don’ts

Do click anywhere outside the selection on the page or press an arrow key on
the keyboard to deselect the text.

Do not forget to select the desired text before using any option for which
prior selection of the text is mandatory, like deleting any text, replacing the
text etc.

Learner’s Observations
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Format the document using Font dialog box in MS Word.

Objective

After completing this practical you will be able to use Font Dialog Box to format
the document.

Software Required

Windows XP or higher version.

MS-Office 2007 or higher version

Prerequisite

Knowledge of working in MS-Word.

Procedure

The Font dialog box allows you to choose from a larger selection of formatting
effects.

Follow the steps to format text in a document:

Step 1: Select the text where formatting needs to be applied.

Step 2: Select Home →→→→→ Font and click on the down arrow key located at the
lower right side on the subtask menu to access the Font dialog box.

Step 3: Select the desired font formatting style like size, color, effects etc. from
the specified boxes.

Step 4: Click on the “OK” button.

Step-5: Click anywhere outside the selection area.

You will notice that the chosen style has been implemented on the selected text.
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Dos and Don’ts

Do remember to select the text before applying any formatting styles.

Do not apply multiple styles altogether on the same text unnecessarily, as it
may end up spoiling the overall impact of the document.

Learner’s Observations
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Insert suitable “Border” to the document or paragraph in the document.

Objective

After completing this practical you will be able to insert suitable “Border” to the
document or to a particular paragraph in the document.

Software Required

Windows XP or higher version.

MS-Office 2007 or higher version.

Prerequisite

Knowledge of working in MS-Word.

Procedure

Different types of borders can be applied to the document to enhance its
appearance. Follow the steps:

Step 1: Choose Home →→→→→ Paragraphs and click on the Border button to display
“Border and Shading” submenu. The “Borders and Shading” dialog box will
appear.

Step 2: Click on the appropriate borders box.

Step 3: Select Paragraph or Whole document option under “Apply to:” drop
down submenu.

Step 4: Click OK.

Desired border is inserted into the document or paragraph.
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Dos and Don’ts

Do remember to observe the preview in the preview box before clicking the
“OK” button.

Learner’s Observations
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Design a document in MS-Word to spread awareness about “Covid-19”and then,
use the Mail Merge feature of MS Word to merge this document with names and
addresses of your five friends.

Objective

After completing this practical you will be able to use the mail merge feature of
MS-Word.

Software Required

Windows XP or higher version.

MS-Office 2007 or higher version.

Prerequisite

Knowledge of Mail merge feature of MS-Word.

Procedure

To start the Mail Merge Wizard, select Mailings →→→→→ Start Mail Merge. Then
select Step by Step Mail Merge Wizard option on the subtask bar.

The Mail Merge Wizard menu will appear on the screen. The Wizard has 6 steps
to create a mail merged document.

Follow the steps as given below:

Step-1: Select Document Type, i.e., “Letters” and click on the Text: “Next:
Starting Document”.

Practical 18
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Step-2: Select any one option out of the three options and click on the Text:
“Next: Select recipients”.

Step-3: In this step, you have to select a list of recipients or address to whom the
drafted letter will be addressed and dispatched. If you do not have existing
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database information, you must create your own data source of the fields of
information that will be inserted into the letter or any other main document. For
example, a Mail Merge letter you have created earlier might require that you have
the following fields in address list of students as data source: Name, Address1,
Address2, City, State, and PIN Code. After selecting the data, now click on the
Text: “Next: Write your letter”.

Once you have created your main document and data source document, the next
two steps in mail merge are to insert merge fields in the main document and then
merge data in the main document.

To merge the fields in the main document you have to follow the given steps:

Step - 4: Click on the location of your letter where you want the addresses to be
displayed.

Step - 5: Select Address Book option on the dialog box displayed in step 4 of the
Mail Merge Wizard. The Mail Merge Wizard displays the Insert Address Block
dialog box. Using Insert Address Block you can select the individual address field
to be inserted into the main letter. After you complete the main document and
insert all of the merge fields, click on the Office Button and choose Save As
option. Now select “Word Document” to save the file as a Word 2007 document
or Select “Word 97-2003 Document” to save it as Word 97 or 2003 compatible
document. Name the document, and then click Save. Now your main document
will work as merge document.

Merging the data into the main document is the last step of the Mail Merge
Wizard. Click on the << or >> button to display the preview of the main letter with
address data before you close the merge document and take the printout of the
letter.

Once finished click on the “Next: Complete the Merge” option, on the dialog
box to complete the merging process.

Dos and Don’ts

Firstly, do create the main document and recipient list to avoid any hassle
while merging the document.

Do not add unnecessary fields while creating a recipient list.
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Learner’s Observations
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Start the MS-Excel program.

Objective

After completing this practical you will be able to start the MS-Excel program.

Software Required

Windows XP or higher version,

MS-Office 2007 or higher version

Prerequisite

Basic knowledge of working in Windows operating system.

Procedure

There are different ways to start the MS-Excel program.

Method 1

Step 1: Click on (with the help of mouse) the Start button on the Taskbar.

Step 2: Highlight the All Programs item. The program menu will open.

Step 3: Select Microsoft Office from the list of programs.

Step 4: Click on Microsoft Excel.

Method 2

You can also start Excel 2007 through Run option in the Start menu. Select Start
– Run. A new window will appear. Type Excel in the open text box and click the
OK button. It will open “MS Excel 2007”.
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Dos and Don’ts

Do remember to close those programs which are not in use.

Do not open multiple instances of the same program to avoid any unnecessary
confusion.

Learner’s Observations
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Carefully observe the screenshot of the MS-Excel screen along with the list of
components given below. Identify and write the names of different components in
the respective boxes.

Components of MS-Excel Window:

Sheet Tab, Active Cell, Horizontal Scroll Bar, Column Headings, Ribbon, Row
Headings, Vertical Scroll Bar, Worksheet Tab Scroll Buttons

Objective

After completing this practical you will be able to identify different components of
MS-Excel window.

Software Required

Any Operating system

MS-Excel
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Prerequisite

Basic knowledge of MS-Excel

Procedure

Step 1: Identify different components marked with the lines and empty
boxes.

Step 2: Mention their names in the respective box provided.

Dos and Don’ts

Do refer to your course material in case of any doubt.

Only observe the main components, do not focus on the sub menus at this
moment.

Learner’s Observations
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Create a workbook containing worksheets, enter the following data and save it.

Name Physics Chemistry Maths English

Ashok Sharma 99 99 100 100

Rajesh 88 76 88 88

Rahul 77 99 66 99

Anurag 88 88 78 77

Gaurav 77 77 98 55

Prashant 66 44 88 77

Taslim 52 66 98 88

Ranjeeta 55 77 78 77

Priyanka 77 55 84 75

Monika 88 88 76 98

Objective
After completing this practical you will be able to create a workbook, enter data
and save it for future purposes.

Software Required
Windows XP or higher version.

MS-Office 2007 or higher version.

Prerequisite
Basic knowledge of working in Windows operating system and MS-Excel.

Procedure
Excel allows you to create worksheets much like paper ledgers that can perform
automatic calculations. Each Excel file is a workbook that can hold many
worksheets.
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Follow the steps to create it and enter data:

Step-1: Open MS Excel.

Step-2: Select Blank Workbook.

A new blank workbook will appear on the screen. By default, it will contain three
worksheets. We may add more worksheets if need arises. By default the first cell
of Sheet1 will be active.

Step-3: Enter the required data.

Step-4: Click on the “Office” button → Select “File → Save as” from the drop-
down menu.

Step-5: Select the location where you want to save the file → Type the file name
→ Click on “Save” in the pop-up menu. Workbook will be saved for future
purposes.

Dos and Don’ts

Do remember to observe the location where your workbook is being saved
as it will help you in future to locate it.

Do not save your document with any irrelevant name as it may be tough for
you to recall that name in future.

Learner’s Observations
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Editing data in Excel worksheet.

Objective

After completing this practical you will be able to edit the data in an Excel
worksheet.

Software Required

Windows XP or higher version.

MS-Office 2007 or higher version.

Prerequisite

Basic knowledge of working in Windows operating system and MS-Excel.

Procedure

Editing your Excel worksheet data is very easy. You can edit your data by any of
the following ways:

Option 1

Step 1: Select the cell containing data which needs to be edited.

Step 2: Press F2.

Step 3: Cursor will start blinking at the end of the text in the active cell. Use the
left arrow keys to move to the desired character and use the Backspace key and
erase the wrong entry.

Step 4: Retype the correct entry.

Step 5: Press Enter Key.

Option 2

Select the cell and simply retype the correct entry.
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Dos and Don’ts

If you want only to clear the contents of the cell, select the cell and press the
Delete key.

In case you want to roll back the editing just done by you, click on the Undo
button on the standard Toolbar or select Edit →→→→→ Undo command or use
keyboard shortcut CTRL+Z.

Learner’s Observations
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Using the “AutoFormat” feature of MS Excel to format the cell contents.

Objective

After completing this practical you will be able to format the data in the cell using
the “AutoFormat” feature.

Software Required:

Windows XP or higher version.

MS-Office 2007 or higher version.

Prerequisite

Basic knowledge of working in Windows operating system and MS-Excel.

Procedure

Excel’s AutoFormat feature uses table styles, which are predefined collections of
number formats, fonts, cell alignments, patterns, shading, column widths, and row
heights to have a polished look of specified range of cells.

Excel has many preset table formatting options. Add these styles by following
these steps:

Step 1: Highlight the cells that will be formatted.

Step 2: Select Home tab →→→→→ Style group →→→→→ Format as Table from the Ribbon as
shown in the adjacent figure.

It will show many predefined Table formats.

Step 3: Select any one format.

Step 4: Check “My Table has headers” checkbox →→→→→ click on the “OK” button.

Desired formatting style is applied on the selected cell range.
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Dos and Don’ts

Do remember to keep saving your worksheet at regular intervals.

In case you want to roll back the formatting just done by you, click on the
Undo button on the standard Toolbar or select Edit →→→→→ Undo command or
use keyboard shortcut- CTRL+Z.

Learner’s Observations
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Use formulae in an Excel sheet prepared in Practical No. 21.

Objective

After completing this practical you will be able to use formulae in an Excel sheet.

Software Required

Windows XP or higher version.

MS-Office 2007 or higher version.

Prerequisite

Basic knowledge of working in Windows operating system and MS-Excel.

Procedure

In Excel, formulas are used to calculate results from the worksheet data. When
there is some change in the data, such formulas automatically calculate the
updated results with no extra effort on the part of the user.

A formula can have any or all of the following elements:

Must begin with the ‘equal to’ = sign.

Mathematical operators, such as + (for addition) and / (for division) and
logical operators such as <, >

References of cell (including named ranges and cells)

Text or Values

Follow the steps to enter formula in the cell:

Step 1: Select the cell where you need to enter the formula.
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Step 2: Type = sign

Step 3: Type the desired formula, for example, in the cell F3, to calculate the sum
of marks of various subjects, just type = B3+C3+D3+E3.

Step 4: Press Enter key.

It will return the sum of the marks of Physics, Chemistry, Maths and English in the
cell F3 as shown in the following figure:

Note: when you select or click on a cell which is having some formula, the formula
will appear in the formula bar.

Dos and Don’ts

Do remember to enter the correct cell address in order to get the correct
answer.

Do not forget to start the formula with = sign.
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Using function through the AutoSum feature of MS-Excel.

Objective

After completing this practical you will be able to use functions through the
AutoSum feature of MS-Excel.

Software Required

Windows XP or higher version.

MS-Office 2007 or higher version.

Prerequisite

Basic knowledge of working in Windows operating system and MS-Excel.

Procedure

The sum of cell values can also be done with the help of AutoSum feature also.
Following steps explain how to do that.

Step 1: Click on the cell F3.

Step 2: Select the Formulas tab.

Step 3: Click AutoSum from the function library group.

Step 4: Select Sum.

Step 5: Press Enter.
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Dos and Don’ts

Do remember that apart from sum there are other functions also, like
average, Count Numbers, Max, Min, etc., which can be used as per
requirement.

Do not forget to click on the cell where the formula needs to be inserted
before the process.

Learner’s Observations
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Inserting a chart in MS-Excel worksheet.

Objective

After completing this practical you will be able to insert a chart in MS-Excel
worksheet.

Software Required

Windows XP or higher version.

MS-Office 2007 or higher version.

Prerequisite

Basic knowledge of working in Windows operating system and MS-Excel.

Procedure

Charts allow you to present the data entered into the worksheet in a visual format
using a variety of graph types.

The following steps will explain how to do that.

Step 1: Enter the data in the worksheet. Suppose you entered the data as given
below:
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Step 2: Now select the data range by using the mouse.

Step 3: Click on the “Insert” Tab and select a suitable “Chart type” from the
chart group, as shown in the figure:

Step 4: Select the sub type of the chart.

Desired chart will be inserted in the worksheet as shown below:
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Dos and Don’ts

Do remember that apart from basic charts, a lot more formatting styles can
be implemented on the chart to give it a more professional appearance.

Do not forget to select the suitable chart type as per the type of the data.

Learner’s Observations
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Creating a blank presentation in MS PowerPoint.

Objective

After completing this practical you will be able to open the MSPowerPoint and
create a blank presentation.

Software Required

Windows XP or higher version.

MS-Office 2007 or higher version.

Prerequisite

Basic knowledge of working in Windows operating system.

Procedure

There are different ways to start MS PowerPoint program. One way is using Start
button by following the steps given below:

Step-1 Click on the Start button.

Step-2 In the start menu that appears, select All Programs → MicrosoftOffice →
Microsoft Office PowerPoint 2007.

OR

You can also start your MS PowerPoint program by double clicking on Microsoft
PowerPoint icon present on the Microsoft Office Shortcut Bar (MOSB).

Step-3 Select Blank Presentation. A blank presentation will appear.
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Dos and Don’ts

Do remember to close those programs which are not in use.

Do not open multiple instances of the same program to avoid any unnecessary
confusion.

Learner’s Observations
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Formatting a presentation in MS PowerPoint by applying a Design Template.

Objective

After completing this practical you will be able to format the presentation by
applying a design template.

Software Required

Windows XP or higher version.

MS-Office 2007 or higher version.

Prerequisite

Basic knowledge of working in Windows operating system and MS-
PowerPoint.

Procedure

Design templates are preset designs which can be applied on the presentation to
give it a more professional appearance.

There are two ways to apply a design template on the presentation.

Method 1

Step 1: While creating a new presentation, instead of choosing a blank presentation,
click on the installed Themes box to select the Design Template you want to use.

Step 2: Preview each design by highlighting the template name on the list.

Step 3: Press Create after you have chosen the design:
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Method 2

Step 1: To add a design template or change the existing one, select the Design tab
on the Ribbon.

Step 2: Select the template by clicking on it.

Desired design templates will be applied to the presentation.

Dos and Don’ts

Do remember to keep saving your presentation at regular intervals.

In case you want to roll back the formatting just done by you, click on the
Undo button on the standard Toolbar or select Edit →→→→→ Undo command or
use keyboard shortcut- CTRL+Z.

Learner’s Observations
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Changing Slide Layouts in Presentation.

Objective

After completing this practical you will be able to change the slide layout.

Software Required:

Windows XP or higher version.

MS-Office 2007 or higher version.

Prerequisite

Basic knowledge of working in Windows operating system and MS-
PowerPoint.

Procedure

Follow the steps given below to change the layout template of the current slide:

Step 1: Select Home → Layout command on the menu bar.

The Slide Layout dialog box appears with nine layouts.

Step 2: Click on any one of the layout thumbnail images. Desired slide layout will
be applied to the presentation.

Dos and Don’ts

Do remember to keep saving your presentation at regular intervals.

In case you want to roll back the slide layout setting just done by you, click
on the Undo button on the standard Toolbar or select Edit →→→→→ Undo
command or use keyboard shortcut, CTRL+Z.
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Save, Close and Exit PowerPoint program.

Objective

After completing this practical you will be able to save your presentation, close it
and exit from the PowerPoint program.

Software Required

Windows XP or higher version.

MS-Office 2007 or higher version.

Prerequisite

Basic knowledge of working in Windows operating system and MS-
PowerPoint.

Procedure

Follow the steps given below to save the presentation:

Step 1: Select Office button →→→→→ Save As command on the menu bar or simply
click on the Save button on the toolbar on top.

Step 2: Choose the folder and drive that your file will be located, type the name
of the file, and then click Save button in the Save As dialog box.

Close the Presentation

Follow the steps to close the current presentation slides file:

Step 1: Select Office button.

Step 2: Close command on the menu bar.

Presentation will be closed. If the file contains any unsaved changes, you will be
prompted to save the file before closing.
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Exit Powerpoint Program

When you have finished your work in PowerPoint and closed all the files, you can
quit the PowerPoint program by following steps as given below:

Step 1: Select Office button.

Step 2: Choose the “Exit PowerPoint” command from the menu bar. The
PowerPoint window will be closed.

Dos and Don’ts

Try saving PowerPoint presentations in Web Page Presentation style by
choosing the “Web Page” command from the “Save as type” box while
saving.

Do not give irrelevant names to your presentation while saving.
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